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Chapter 1
Introduction

PFPDView is a software option package for OI Analytical’s Model
5380 PFPD (Pulsed Flame Photometric Detector). This program can be
used to reprocess (post-run) either portions of or an entire
chromatographic run under different PFPD operational parameters
without the need for rerunning the chromatographic analysis. This
allows the parameters to be adjusted for optimal selectivity without the
extra time and expense of rerunning the analysis to find the ideal
parameters. Post-run analysis facilitates method development, dual
gate optimization, and technical support. It can also provide structural
information on unknown compounds.

Features 

• Post-run display of emission scans, gate parameters, and chromato-
grams.

• Allows the operator to review individual time emission profiles to
obtain some heteroatom structual information of unknown com-
pounds.

• Permits post-run gate optimization for improved sensitivity and
selectivity.

• Permits off-line optimization of the dual gate modes to enhance
interhetroatom selectivity.

• Allows the operator to reanalyze off-line chromatographic runs
under different PFPD parameters.
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The PFPDView software package includes:
• One floppy disk (3.5")
• One operator’s manual (Part #311019)

Specifications 

Hardware Requirements
• Pentium/100 MHz IBM-compatible platform (minimum)
• 2 MB hard disk space
• 16 MB RAM  minumum
• VGA monitor (or higher)
• One serial port (RS-232-C) (16550 buffered UART 38.4 K baud

required)

Host Software Requirements
• Windows 3.1x, Windows 95, Windows 98, or Windows NT
• OI Analtyical’s WinPulse™ software
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Chapter 2
Installation

This chapter explains installation of the PFPDView software. Before
installing PFPDView, verify that WinPulse Version 2.0 is installed in
the PC.

Note: The firmware in the Detector Controller must be Version 2.01
or higher (see the label on the firmware chips). If an earlier
version is installed in the Detector Controller, replace the chips
with the ones provided with the PFPDView software. Follow
the chip installation instructions included in the Start-up Kit.

Note: PFPDView is designed to run under Microsoft® Windows
version 3.1 or later. For information on how to use Microsoft
Windows, refer to the appropriate Windows documentation.

Note: PFPDView is designed to operate with a PC mouse. For
information on how to use a mouse, refer to the appropriate
Windows documentation.

Installation 

Before installing the PFPDView software, confirm that the minimum
hardware and software specifications required to run PFPDView exist
in the PC on which PFPDView is to be installed (see “Specifications”
in Chapter 1). Begin installation in the Windows environment.

Note: It is recommended that you exit all Windows programs before
installation.

1. Insert the 3.5" PFPDView floppy disk into the appropriate floppy
disk drive.
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2. Under the Start menu (or File menu in Windows 3.1x), select
Run.

3. Type a:\setup or b:\setup depending on which drive the PFPDView
floppy disk is in, and press [Enter].

�� A welcome screen will appear asking whether or not to install
PFPDView. Click on Next to install PFPDView.

5. Follow the directions given. (In the NAME and COMPANY input
window, move from the NAME box to the COMPANY box by
pressing [Tab]. Do not click on Next until after all information has
been entered.)
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Chapter 3
Overview of PFPDView

PFPDView is an optional software program that permits post-run
processing of the data files collected using the WinPulse software for
the Model 5380 PFPD. PFPDView is accessed either from the
WinPulse Main Screen or by clicking on the PFPDView icon.

This chapter describes the PFPDView Screen and the menu features
available.

PFPDView Screen and Menu Features 

 The PFPDView screen and menus have been organized for efficiency.
All of PFPDView’s functions can be accessed by navigating these
menus. Table 3.1 shows the complete menu/submenu structure for
PFPDView. These menus are accessed from the PFPDView Screen.

Overview of the PFPDView Screen

The PFPDView Screen consists of a toolbar and separate graphics
displays for the time emission profile and the chromatogram. The top
window is the selected time emission profile for the pulse indicated by
the cursor line in the chromatogram (displayed on the PFPDView
Screen). The lower window is the resulting chromatogram for the
entire analytical run, calculated from the specified gate parameters
from all of the collected time emission profiles. See Figure 3.1.

The analysis time for the particular displayed time emission profile
(pulse) is displayed on the first line of the legend. The vertical axis (Y)
on the chromatogram represents the (peak) intensity, and the horizontal
axis (X) is the retention time of the peak in seconds. Exact retention
time information is generally not available unless the Model 5380
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Detector Controller is synchronized (via remote start) with the GC’s
run start.The Y-axis of the time emission profile displays the intensity
level, and the X-axis is the pulse time in milliseconds.
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Figure 3.1. PFPDView Screen

Cursor Line

Gate

The time emission profile (pulse) for a specific point on the chromato-
gram can be viewed three ways:  (1) clicking on the selected area/time
of the chromatogram, (2) clicking on the appropriate arrow button (
or ) on the toolbar, or (3) pressing the arrow keys on the computer
keyboard until the vertical cursor line is on the specific point.

The cursor line is a very helpful tool. It allows each individual pulse
emission in the chromatogram to be viewed individually. Holding the
arrow key down on the keyboard will rapidly scroll the cursor line
across the chromatogram. By viewing each pulse, certain elements and
their ratios can be identified. For more information, see “Analyzing
and Viewing Data” in Chapter 4.

The horizontal colored lines in the time emission display indicate the
gate settings for the corresponding mode. To add or remove these
indicators, simply click in the appropriate check box in the legend.

Note: Chromatograms for up to five gate settings can be displayed
simultaneously. Each chromatogram can be displayed or
hidden by clicking on the mode of interest in the chromato-
gram legend.
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The toolbar at the top of the screen allows the operator to perform the
following operations.

Imports a previously saved chart.

Prints the displayed plot(s).

Displays the previous time emission profile.

Displays the next time emission profile.

Zooms in on the selected chromatogram.

Zooms out on the selected chromatogram.

Accesses the Help files.

File Menu
Open opens an existing data file (*.dat).

Close closes the opened data file.

Save cfg File saves the file that is currently
opened as a configuration file (*.cfg) that
can be used in WinPulse.

Open cfg File opens a saved configuration
file (*.cfg).

Print prints the current data to a file or
printer.

Printer Setup allows the operator to set up
the printer or file where the data will be
sent.

XXXX.DAT lists the last three data files
that have been opened in PFPDView.

Exit exits PFPDView.
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Edit Menu
Send to Clipboard sends the current time
emission profile view, chromatogram view,
or both views to the clipboard.

View Menu
Scan allows the operator to chose options
for viewing the time emission profile.

Grid - Adds grid lines to the time emission
profile.

Legend - Shows or hides the legend. The
legend can be moved by dragging it.

Line Styles - Switches between dashed and
solid lines.

Next and Previous - Move through the time
emission profiles.

Chromatogram allows the operator to
chose options for viewing the chromato-
gram.

Grid - Adds grid lines to the chromatogram.

Legend - Shows or hides the legend. The
legend can be moved by dragging it.

Line Styles - Switches between dashed and
solid lines.

Axis Labels - Hides or shows the time axis
on the chromatogram.
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Zoom In zooms in on the entire selected
plot (time emission profile or chromato-
gram) viewing area.

Zoom Out zooms out on the entire selected
plot (time emission profile or chromato-
gram) viewing area out.

Previous View displays the previous
viewing area.

Restore restores the chromatogram to its
original view.

Snap to Trace - Holding the right mouse
button on either the emission profile or the
chromatogram displays a crosshair cursor.
With Snap to Trace selected, the origin of
the crosshair cursor follows the points on
the emission profile or chromatogram as the
cursor moves. Both the time and amplitude
values of the points will be displayed at the
bottom of the screen.

Toolbar hides or shows the toolbar.

Status Bar hides or shows the status bar.

Tools Menu
Recalculate Chromatogram recalculates
the chromatogram for the data file that is
open.

The ghosted (grayed) options are not
currently available.
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Option Menu
Gate Mode accesses the Gate Parameters
screen, which is used to set gate values and
identify gate mode labels. For more infor-
mation, see “Gate Parameters Screen” in
Chapter 3 of the Model 5380 PFPD
Operator’s Manual.

Log opens the run log. All changes that are
made while using PFPDView will be
recorded in this log file.

Timed Events accesses the Timed Events
screen. For more information, see “Timed
Events Screen” in Chapter 3 of the Model
5380 PFPD Operator’s Manual.

Board/Channel accesses the Board/Chan-
nel Parameters screen, which is used to set
board/channel parameters. For more infor-
mation, see “Board/Channel Parameters
Screen” in Chapter 3 of the Model 5380
PFPD Operator’s Manual.

Window Menu
Cascade overlaps the plots.

Tile places the plots side by side.

XXXX.DAT lists the data file(s) that are
currently open in PFPDView.
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Chapter 4
Operation

This chapter provides information on operating PFPDView. To access
additional on-line information, click on the Help menu in the
PFPDView screen or the Help button in dialog boxes.

Note: PFPDView is designed to run under Microsoft Windows
version 3.1 or later. For information on how to use Microsoft
Windows, refer to the appropriate Windows documentation.

Note: PFPDView is designed to operate with a PC mouse. For
information on how to use a mouse, refer to the appropriate
Windows documentation.

Starting PFPDView 

PFPDView can be started two ways:

• Double-click on the PFPDView icon in Program Manager (Win-
dows 3.x or NT 3.51) or select PFPDView from the Start Menu
(Windows 95 or NT 4.0); OR

• From the WinPulse Main Screen, go to the Utilities menu and
select Use PFPDView.
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Loading a Data File 

Data files used in PFPDView are created in the WinPulse program
supplied with the Model 5380 PFPD. These files can be created in
WinPulse either manually from the main screen (by pushing the
Record button) or automatically by using the record timed event
function. Once collected in WinPulse, the *.dat files can be opened and
worked with using PFPDView.

1. Go to the File menu and select Open.

2. Select the data file that you want to open, then click OK. This will
load the selected data file to PFPDView.

Note: PFPDView calculates a chromatogram from the stored pulses
(time emissions) in the data file for every gate mode in the
current gate table (i.e., for each mode that was in the Gate
Parameter List in WinPulse  when the file was created) (see
“Gate Parameters Screen” in Chapter 3 of the Model 5380
PFPD Operator’s Manual). The progress of this generation is
indicated in the lower left corner of the main screen.

3. After a data file is loaded, a new configuration file can be loaded if
needed. Go to the File menu, and select Open cfg File. Click on
OK.

Note: The chromatograms will be recalculated whenever a new
configuration file is opened.

Note: If the data was collected using the WinPulse Record button and
not the GC remote start, the time scale used for the chromato-
gram in PFPDView will not match the one generated by the
GC data handling system. A dialog box will appear to notify
you of the fact. See Chapter 5, “Troubleshooting” for more
information.
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Analyzing and Viewing Data 

By using the cursor line in the chromatogram display, each pulse
emission in the chromatogram can be viewed individually (see Figure
3.1).

By observing individual pulses, the operator can obtain several types of
useful information. The time emission profile provides useful informa-
tion regarding the flame characteristics in the PFPD, and it can be
easily observed from the emission whether the detector flows are
properly optimized and tuned. Cleanliness of the detector can also be
observed by noting the time emission profile in the early (1.5–3.0
msec) time frame.

Additionally, by observing the pulses, the operator can obtain basic
elemental information for peaks of interest. For example, one can
determine from the pulse (post-run) whether a peak has either S or P in
it, or a combination of both. Relative concentrations of each element in
a specific peak can also be determined by noting the time emission
profile, as shown in Figure 4.1. This is especially helpful when trying
to determine unknown composition.

Background

Tributyl Phosphate - P only

Malathion - 2X S vs. P

S GateP Gate

Figure 4.1 Using PFPDView to Obtain Heteroatom Composition Information

Chlopyriphos - Equal S & P
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1. Place the cursor line on the peak to view by clicking on the specific
peak on the chromatogram or by using the arrow keys on the
keyboard to move the cursor line to the specific peak.

Note: To zoom in on a specific area on either the emission profile or
the chromatogram, hold down the left mouse button and drag
the cursor over the area to be zoomed in on. Release the mouse
button. To return to the original view, go to the View menu and
select Restore.

2. If necessary, isolate the specific gate by checking/unchecking the
mode (gate) in the legend.

Adjusting the Parameters and Creating
New Configuration Files 

To observe what a chromatogram would look like if collected using
different gate parameters, PFPDView can be used to change the gate
parameters, and the resulting chromatogram will be displayed. Once
optimized, a new configuration file to use in WinPulse can be gener-
ated with PFPDView. The results of the new parameters can be viewed
and adjusted without the need to rerun the analysis. This allows the
chromatograph to be reanalyzed off-line using only a single chromato-
graphic run.

1. Go to the Options menu, and select the appropriate screen to be
accessed (Gate Mode, Timed Events, or Board/Channel).

2. Make any necessary changes. Note that all the fields cannot be
modified. For information on the Gate Parameters Screen, Timed
Events Screen, and Board Channel Parameters Screen, see the
Model 5380 PFPD Operator’s Manual. (Figure 4.2)

For example, to change a gate parameter, go to the Option menu,
and select Gate Mode to access the Gate Parameters screen. Click
on the mode to be modified, and make the changes in the specific
parameter(s) to be changed.
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4. Click on Change for the changes to take affect.

5. Click on OK. PFPDView will recalculate the chromatogram using
the new parameters.

6. To save the new parameters in a new WinPulse configuration file,
go to the File menu and select Save cfg File. Enter the name of the
configuration file to be saved, then click on Save. This configura-
tion file can then be opened and used in WinPulse. Alternatively,
the new PFPD parameters can be simply manually entered directly
into the WinPulse program.

Changes in the gates
in PFPDView will result
in a new chromatogram
being generated and
displayed

Figure 4.2.  Post-Run Reprocessing of Gate and Timed Events Parameters
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Optimizing the Dual Gates 

Another beneficial use of PFPDView is to easily optimize the very
powerful tool of the PFPD referred to as the Dual Gate Mode of
operation to eliminate interferences between two species. This tech-
nique allows the selectivity of the PFPD to be significantly enhanced
using the dual gate subtraction mode. For more information, see
“Appendix C” in the Model 5380 PFPD Operator’s Manual.

1. Load a data file (see “Loading a Data File” in this chapter).

2. Go to the Options menu and select Gate Mode. In the Gate
Parameters List, select the mode to optimize. Change the Alpha
value and the Gate B parameters as needed. Click on Change.

3. Click on OK. The chromatogram will be recalculated and dis-
played using the new gate parameters. (See Figure 4.3.)

4. Evaluate the chromatogram. Repeat steps 2–3 until the proper
Alpha value is obtained. (See Figure 4.4.)

Optimization by simply
changing the alpha value
and immediately viewing 
the results 

Figure 4.3.  Post-Run Optimization of Gate Alpha Values
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tributyl phosphate

Single Gate

Alpha = 0.5
Too Low

Alpha = 2.5
Too High

Alpha = 1.40
Good Value

Elimination of 
S Matrix using 
dual gate subtraction
optimized post run 
with PFPDView

5. Go to the File menu and select Save cfg File to save the new
value(s). Enter the name of the configuration file to be saved, then
click on Save. The new configuration file can now be called up in
WinPulse and used for future runs. Alternatively, manually enter
the final optimized parameters into the WinPulse Gate Parameter
Screen.

Exporting the Chromatogram 

Each chromatogram displayed in the PFPDView screen can be ex-
ported as a new GC data file in an AIA format. These files can be
imported into most chromatographic data systems (like Agilent
ChemStation) that accept the AIA file format. This permits the opera-
tor to view, reprocess, print, or reintegrate the GC run under the new
PFPD parameters without rerunning the sample.

Note: Caution must be taken when reanalyzing post-processed runs
as calibration procedures must take into account any PFPD
parameters that have been changed.

Figure 4.4.  Post-Run Optimization of Dual Gate to Eliminate S Interferences
in a P-Optimized Analysis
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1. Go to the Options menu, and select Gate Mode. This will access
the Gate Parameter screen.

2. In the Gate Parameters List, select the desired gate mode to be
exported as an AIA file (see Figure 4.5). One of the modes in the
Gate Parameters List must be selected to activate the Export AIA
button.

3. Under DC Offset, enter the desired offset if needed (must be less
than the lowest point in the chromatogram).

4. Click on Export AIA. This will access the Export AIA Data screen
(Figure 4.6).

5. Enter in all the necessary information. Fields that may be modified
are displayed with a white background. After all the necessary
information has been entered, click Save As.

6. Enter the name of the export file to be saved, then click on OK.

7. To import the file into a data system, refer to the data system’s
operator’s manual.

8. Reprocess the chromatogram as desired using the GC data system.

Figure 4.5.  Gate Parameters Screen
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Figure 4.6.  Export AIA Data Screen

Additional PFPDView Uses  

PFPDView stores all the pulsed flame emissions during the analytical
run. This enables the operator to improve several important PFPD
analytical capabilities by manipulating the two gates.

For more information on the dual gate approach for enhanced PFPD
operation, read the following paper:

Amirav, Aviv; Jing, Hongwu. Pulsed Flame Photometer Detector
for Gas Chromatography. Anal. Chem. 1995, 67, 3305–3318.

The dual gate approach and post-run data analysis with PFPDView can
be used to enhance the PFPD performance.

Optimal gate delay for best sensitivity or selectivity
PFPDView can be used for post-acquisition optimization of the gate
start and stop set points. These gate settings can have a significant
effect on the results. Either the sensitivity or the selectivity, or both,
can be optimized using PFPDView.
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Simultaneous Sulfur and Carbon Analysis
Simultaneous sulfur and carbon analysis can be important for gasoline
and other related petrochemical analyses. A normal gate (from 6 msec
to 24.9 msec) is used for detecting the sulfur, and a second, narrower
gate is used for detecting the carbon (from 1.5 msec to 3 msec). If the
carbon and sulfur emissions overlap, a delayed start time can be set for
the sulfur (7 or 8 msec, for example), greatly improving the sulfur
selectivity without sacrificing sulfur detectivity. However, it will be
necessary to use the dual gate subtraction technique to remove the
contribution of the sulfur from the carbon emission. The sulfur
emission usually exists to a small degree within the carbon gate, and a
small alpha coefficient is sufficient to remove the sulfur contribution.
PFPDView can be used to determine the best start time for the sulfur
gate and the best alpha coefficient for subtraction of the sulfur
contribution from the carbon gate.

Simultaneous Multi-element Analysis
Compounds containing both sulfur and phosphorus, such as some
pesticides, can be analyzed by using a UV-34 optical filter. The dual
gate subtraction approach is used to generate simultaneous, single
element chromatograms for both heteroatoms. (See Appendix C in the
Model 5380 PFPD Operator’s Manual for information on dual gate
subtraction.) Additional optical filter/PMT configurations are available
for simultaneous analysis of other heteroatom pairs, such as sulfur and
nitrogen or phosphorus and nitrogen.

Reducing Sulfur Interference in Phosphorus
Pesticide Analysis
The emission times of specific heteroatoms often overlap (e.g., the tail
end of the phosphorus (P) emission overlaps with the initial phase of
the delayed sulfur (S) emission). The selectivity for the delayed,
extended S emission relative to the earlier P emission can be enhanced
by simply moving the start S gate to a point beyond the interfering P
emission (e.g., 16–20msec). This improvement in the selectivity
between phosphorus and sulfur will result in a small decrease in the
sulfur sensitivity. Eliminating the S emission from the P emission with
simple adjustment of gate settings is less easy, because the S emission
overlaps with a significant portion of the phosphorus emission.
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However, using the dual gate enhanced mode of operation allows the
operator to significantly increase phosphorus selectivity relative to
sulfur (and vice versa).

This optimization of gates is easily done using the PFPDView software
after running just a single analysis. Once optimal dual gate parameters
are obtained, they are simply entered into the gate table of the
WinPulse program and used for all subsequent analyses. A detailed
description of how this enhanced selectivity is accomplished for
phosphorous versus sulfur can be found in OI Analytical Application
Note #1127.

Elemental Identification with the Gated Response
Ratio (GRR)
The Gated Response Ratio (GRR) technique is a qualitative technique
that can be used to identify whether there are multiple heteroatoms
present within a specific chromatographic peak without going through
the full dual gate subtraction procedure. The GRR technique is
particularly useful where complex sample matrices make individual
peak identification difficult (e.g., identification of organophosphorus
pesticide residues in food matrices containing sulfur). To determine the
GRR, a single run is made with compounds containing known
concentrations of the heteroatoms of interest. The ratio of the peak
heights is a unique number that can then be used to identify whether
one or both of the heteroatoms are present. To use the GRR technique
for an unknown, one gate is defined for the compound of interest (e.g.,
4 msec to 10 msec for P), and a second gate is defined as the P/S ratio
(see Figure 4.7). Comparing the P chromatogram to the P/S
chromatogram will then provide information about whether there is
sulfur interference present in the target phosphorus peak.

Generally, sulfur and phosphorus can be identified by their emission
even without any GRR; however, at low levels or if both elements are
in a given compound, the GRR may be the best way to confirm this
information. The process is qualitative only; it will only indicate
whether one or two specific heteroatoms are present in a given
compound peak (e.g., S, P, or S and P). The GRR technique will not
give quantitative information about the relative amounts of the
individual heteroatoms; for quantitative results the dual gate
subtraction technique is necessary.
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Extended Sulfur Measurement Dynamic Range
Using the Gated Response Ratio
Due to its quadratic response, the dynamic range for sulfur is limited to
about  2.7 orders of magnitude. The dynamic range for sulfur, and
other elements, can be extended by approximately one order of
magnitude using the Gated Response Ratio (GRR). When the sulfur
emission becomes saturated, it can be observed that only a portion of
the full sulfur gate has reached a maximum; the early portion of the
sulfur emission will not reach maximum or electronic saturation
conditions. To use the GRR technique, one gate is defined in the usual
manner (e.g., 6 msec to 24.9 msec for sulfur), and a second gate is
defined with minimal or no delay and a 2–3 msec gate width (e.g.,
4 msec to 6 msec) (see Figure 4.8). Using a sulfur standard that does
not reach saturation conditions, simultaneous chromatograms for both
gates are acquired, and the GRR is calculated by dividing the response
from the first (normal) gate by the response from the second (early)
gate. Then, when a normal sulfur signal (6 msec to 24.9 msec) is
acquired under saturation conditions, the response from the early gate
(4–6 msec) can be multiplied by the GRR to determine the estimated
delayed emission response, thus extending the overall dynamic range.
Note that the PFPDView software by itself allows the operator to
extend the measurement resolution up to 24 bits versus 16 bits (Digital
to Analog Converter (DAC)) existing within the PFPD’s signal

Figure 4.7. Gate Parameters for GRR Technique for
Unknown
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processing circuitry. This additional information can be used to extend
the dynamic range of the detector if reprocessing the chromatogram
using PFPDView.

Quenching Identification and Elimination
Quenching occurs when a high concentration of hydrocarbon co-elutes
with the targeted sulfur compound and causes a reduction in or loss of
the sulfur emission. Adjusting the chromatographic conditions so that
the hydrocarbon and the sulfur peak of interest are separated spatially
can eliminate quenching. It can also be �������������	
	��
�����
��	�������

��������
���
����������	����������	�����������
��
Using the larger combustor increases the combustion volume and
reduces the potential for sulfur emissions being “intercepted” and
absorbed by the competing hydrocarbon moiety.

PFPDView can be used directly to observe the emission profile for any
area of the chromatogram where quenching is suspected. If the
characteristic sulfur emission collapses or folds in on itself (i.e., does
not extend beyond 20 msec) and is immediately and simultaneously
replaced by a saturating hydrocarbon emission, quenching has taken
place.

The Gated Response Ratio technique can also be used to determine
qualitatively whether quenching has occurred, which is not always

Figure 4.8.  Gate Parameters for Extended Sulfur
Measurement
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apparent from the appearance of a chromatogram. Two gates are
defined, one for the normal sulfur emission (6 msec to 24.9 msec) and
one for the early segment of the emission (6 msec to 9 msec). The GRR
for the two responses is calculated for a nonquenching (and
nonsaturating) peak. Comparing the peak heights from the two
chromatograms acquired for an unknown can easily identify
quenching. The gate response ratio will be changed by quenching, and
this change will be the indication that quenching has occurred.

The term “quenching” is also sometimes used to describe the self-
quenching effect seen when there are very high concentrations of sulfur
present. In this case, the concentration of sulfur dimers in the
combustor is high enough that the sulfur “self-absorbs” or “quenches”
the emissions before they can reach the light tube and be transmitted to
the PMT. When this type of quenching has occurred, the top of the
chromatographic peak will be shaped like the letter “M”, having the
appearance of a split peak. This type of quenching is easily identified
using PFPDView by observing the change in the characteristic sulfur
emission for a suspected peak. The sulfur emission will reach
saturation and then collapse, but it will not be replaced with a
simultaneous hydrocarbon emission as described earlier. Using a 3-mm
I.D. combustor can reduce the chances of self-quenching.
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PFPDView may display messages under normal operating conditions.
For assistance with error messages, contact OI Analytical Customer
Service at (800) 336-1911 or (409) 690-1711.

Time Scales 

If data was collected using the WinPulse Record button and not the GC
remote start, the time scale used for the chromatogram in PFPDView
will not exactly match the one generated by the GC data handling
system. Three different types of datafiles can result.

• WinPulse is in Run and the Clock is Updating
The time base may not correspond to the chromatographic time
being recorded. Relative time differences between PFPD pulses
will be accurate; however, the absolute time will appear to be
incorrect.

• WinPulse Record is Pressed Prior to GC Start (with start cable
connected) If recording is started prior to run start, an injection
will be made into the GC and the Detector Controller will detect a
run start signal. WinPulse will close the file that is currently open,
increment the counter, and open and start recording to a new file.
The first time emission profile will occur immediately after the run
start signal is detected by the Detector Controller.

• WinPulse is in Ready and Does Not Advance to Run
The elapsed time from run start remains at zero (0) for every time
emission data set. When PFPDView opens this file, the secondary
time base (time elapsed from the previous pulse) will be “summed”
to generate the time base.
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